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Introduction

Welcome

This documentation covers using wwSafe from WWPass. It is written for Windows users of the wwSafe client.

wwSafe is a client/server collaboration tool that allows enterprise users to securely store and share confidential 
files in the cloud.

The  files  might  be  contracts,  patents,  legal  documents,  or  intellectual  property.  They  can  be  shared  with 
individual users and with groups.

Files are kept safe in wwSafe Cabinets. These are designed to lock out data breaches.

Files can only be accessed by and shared with authorized users. To ensure that a user is authorized, they must 
authenticate  their  identity  with  a  PassKey when  they  log  into  wwSafe.  A PassKey  is  a  cryptographic  and 
anonymous authentication device from WWPass.

Authorized users can include internal users such as enterprise employees and external users such as clients  
who need to safely share information with an enterprise.

What makes wwSafe secure is WWPass encryption and authentication technology.

When users upload files to a wwSafe Cabinet,  encryption is used for both file data and file  metadata.  The  
metadata includes file attributes such as date of creation and size plus authentication information needed for file  
access:

 File data is encrypted and stored in the cloud. Files are not seen by WWPass.

 File metadata is encrypted, fragmented, and dispersed in WWPass data centers around the globe so 

that there is no single point of vulnerability.

The only way users can reconstruct file metadata and access stored files is by authenticating with a PassKey.

How wwSafe Works

Each wwSafe user is assigned one or more Cabinets for storing files in wwSafe. Cabinets are the main storage  
unit. They can be thought of as virtual drives in the cloud. 

You access your Cabinets via the wwSafe client, which lets you easily add files to wwSafe and share them with 
other users. 

To manage and share files, you can use groups, folders, sharing, permissions, and audit features: 

 Files and folders. You can upload files in any format to your wwSafe Cabinets. The files are encrypted 

and stored in the cloud.  They can only  be accessed with your PassKey. To organize files within  a  
Cabinet, you create folders and subfolders. These descend from the Cabinet in a hierarchical folder tree. 
When you upload a file from your computer, you select which folder to add it to in wwSafe. Although files  
cannot be opened in wwSafe, you can download files to your computer and open them there. If you 
make changes to a file's content, you can upload the file again as a new revision. At the first login you  
have a curtain number of default Cabinets which can vary from one user to another.
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 Sharing. You can share files with other users by sharing the folders the files are stored in. A folder can 

be shared with individual users, one or more groups, or a combination of users and groups. A blue 

sharing symbol   indicates which folders you shared with other users. A yellow sharing symbol   
indicates which folders were shared with you. To see which users and groups are sharing a folder, you 
can check the Folder Permissions list for that folder. Sharing can be revoked as needed for all users, an 
individual user, or a group.

 Groups. You can use  groups in order to easily share the same content with multiple people such as 

colleagues in your department. For example, you might share project-related folders and their files with 
the Project Managers group. Groups are created by wwSafe Security Administrators. When you need a 
new group, send a request to a Security Administrator and provide the name to use for the group, a brief  
description of its purpose, and a list of the users to invite to the group. If the Security Administrator gives  
you Share and Modify Users permissions for the group, you can invite users to join.

 Permissions. These provide fine-grained access control for shared folders and groups:

o When you share a folder with a user or group, you can assign permissions for the folder. These  

determine what actions the user or group members can perform for the folder and its files. You 
might allow all sharing users to access folder content but only one sharing user to add files.  
Folder permissions are the same for all group members. To see permissions for a folder, check 
its Folder Permissions list.

o When you invite other users to join a group, you can assign permissions for the group. These 

determine what actions group members can perform for the group. You might allow all group 
members to see who belongs to a group but only one group member to invite users to join. 
Permissions can be different for each group member. The Group Member Permissions window 
shows the permissions of each group member. 

You are the owner of each folder you create, and have all permissions for that folder. Before you leave 
an enterprise or change roles, you can assign ownership of your folders to other sharing users.

 Audit trails. These let you track the operations performed for Cabinets, folders and groups. Audit trails 

are shown in History windows that include operation name, name of the user who performed it, and date 
it was performed. Your can track your own login history in the User History window. 

 Note: wwSafe Cabinets are created by wwSafe IT Managers using the wwSafe Management Utility. The 
amount of storage space in each Cabinet is determined by a wwSafe IT Manager. 
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wwSafe Documentation

Documentation What It Covers Who It's For Where to Find It

Installation guide Installation, 
configuration, and setup 
overview for wwSafe. 

 IT managers

 System administrators

 wwSafe Security 

Administrators

 wwSafe IT Managers

Available in a PDF 
file from WWPass 
sales.

Help for wwSafe 
Management Utility

Setting up and managing 
wwSafe with the wwSafe 
Management Utility.

 wwSafe Security 

Administrators

 wwSafe IT Managers

Click Help link at top 
of Management 
Utility interface.

Help for wwSafe 
client

Using the wwSafe client 
and setup performed 
from the client.

 wwSafe end users

 wwSafe Security 

Administrators

 wwSafe IT Managers

Select User Guide 
from the Help menu 
at top of client 
interface or click F1.

Need assistance from your enterprise?

There are two types of administrative users who manage wwSafe – wwSafe Security Administrators and wwSafe  
IT Managers.

Contact a wwSafe Security Administrator when you need:

 A group for folder sharing.

 To add members to an existing group (you can add members if you have Share and Modify permissions)

Contact a wwSafe IT Manager when you need more storage space in one of your Cabinets.

Need assistance from WWPass?

If you encounter a problem with wwSafe or have a question, you can contact the WWPass Service Desk as 
follows:

Phone 1-888-WWPASS0 (+1-888-997-2770)

Email support@wwpass.com

Online Support form
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Report a Problem from the Security Console

An easy way to report a problem is to email the Service Desk directly from the WWPass Security Console. This  
is installed on wwSafe client computers along with WWPass Security for Windows Desktop, the software pack 
needed to activate and authenticate with your PassKey from WWPass.

All WWPass logs available on the wwSafe client computer are automatically attached to the email.

Logs  contain  information  that  can  help  the  Service  Desk  troubleshoot  problems.  They  are  located  in  
C:\Users\username\AppData\Local\WWPass\wwpass.log and should not be changed before they are sent to the 
Service Desk.

To report a problem from the Security Console:

1. Click the mail button  in the upper-right corner of the Security Console.

2. In the Support window that opens, type a description of the problem you need help with. You can also 
type a question.

3. Enter the email address the Service Desk should reply to.

4. Click  to email your report along with logs on the wwSafe client computer. 
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Before you start using wwSafe

Requirements for the wwSafe Client

Requirement Details

Operating system Computer with one of the following 32-bit or 64-bit operating systems:

 Microsoft Windows 7

 Microsoft Windows 8

 Mac OS X 10.8 or 10.9

 Ubuntu 14.04 LTS (Trusty Tahr)

 Ubuntu 12.04 LTS (Precise Pangolin)

Minimum storage requirements for wwSafe are as follows:

 Windows – 50 MB

 Mac – 80 MB

 Ubuntu – 14 MB

Web browser A browser is needed to authenticate into wwSafe with PassKey and activate the 
PassKey.

Supported browsers are:

 Microsoft Internet Explorer 9 and 10 (32-bit and 64-bit) (Windows only)

 Mozilla Firefox 14 to current version

 Google Chrome 20 to current version (Windows and Mac OS)

WWPass products wwSafe client

Requirements for wwSafe Users

These requirements must be met for each wwSafe user – administrative and non-administrative.

Requirement Details

User credentials Ticket or one time login and password for registration. These are provided by 
wwSafe Security Administrator or WWPass cloud domain admin.

WWPass products A KeySet from WWPass.

A KeySet includes the PassKey used for authenticating into wwSafe during 
login from the wwSafe client or Management Utility.

WWPass wwSafe Version 2.1 User Guide 11/10/14

9 of 84



WWPass wwSafe User Guide

Installation

Windows

Follow the steps below to install wwSafe in Windows.

1. Run the wwSafe Setup Wizard.

2. From the Welcome screen, click    to proceed. The installation begins. 

3. When installation is complete, the Completed screen appears.

4. Click    to close the setup wizard.

Mac

Follow the steps below to install wwSafe in Mac.

1. Double-click the wwSafe Installer file  (WWPassWWSafe_VersionNumber.dmg) from Downloads.  The 
WWPass wwSafe window opens.

2. Double-click the WWPass wwSafe Installer icon. The WWPass wwSafe Installer opens with a message 
about the installer package. Click Continue in the message.

3. From the  installer's  “Welcome”  screen,  click  Continue  to  begin  installing  or  updating  the  WWPass 
wwSafe.

4. From the  “Standard  Install”  screen,  click  Install  to  begin  installing  or  updating  wwSafe.  Then click 
Continue Installation in the message that asks if you’re sure you want to install the software now. Finally, 
enter your password and click Install Software. Installation proceeds.

5. When installation is finished, the "installation was successful" message appears.
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Ubuntu

Follow the steps below to install wwSafe in Ubuntu.

1. Download the following file: http://packages.wwpass.com/wwpass.asc

2. Register the file wwpass.asc GPG key using this command:

sudo apt-key add wwpass.asc

 Note: You can combine steps 1 and 2 using this command:

wget -q http://packages.wwpass.com/wwpass.asc -O- | sudo apt-key add -

3. Add the following string to /etc/apt/sources.list:

 For Ubuntu 12.04 Precise Pangolin: deb http://packages.wwpass.com precise main

 For Ubuntu 14.04 Trusty Tahr: deb http://packages.wwpass.com trusty main

4. Run sudo apt-get update.

5. Install wwSafe using this command:

sudo apt-get install wwsafe-client
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Smart Start for using wwSafe

This Smart Start provides a suggested workflow for getting started with wwSafe. Once you are familiar with  
wwSafe features, you can use them in almost any order.

Before you begin

 Activate your WWPass KeySet, which includes the PassKey you need in order to log in and authenticate  

your identity with wwSafe.  If  a KeySet has not  been provided yet,  ask a system administrator or a  
wwSafe Security Administrator how to obtain a KeySet.

 Make sure the wwSafe client is installed on your Windows computer. The client can be installed with the 

wwSafe Setup Wizard. Depending on how software is installed at your organization, wwSafe might be 
automatically installed on your computer by a system administrator.

Smart Start 

1. Present your PassKey

Present your PassKey to your computer. Your PassKey authenticates your identity when you log into wwSafe. It  
ensures that only you can access the files you store in wwSafe. If you remove your PassKey while wwSafe is  
running, you are automatically logged out. To continue using wwSafe, present your PassKey and log in again.

2. Start wwSafe

Start  wwSafe  form the  Windows  start  menu,  authenticate  with  your  PassKey, and open the  main  wwSafe 
window. This contains your wwSafe Cabinets.

Note: The first time you run wwSafe, you specify which wwSafe server to connect to and register your PassKey 
with the server by entering the credentials provided by a wwSafe System Administrator. After you register, you  
can run wwSafe without these credentials.

3. Create folders

Create folders for storing and organizing files in wwSafe. You can create multiple folders and subfolders in each 
of your Cabinets. You can then add files to your folders and share the folders with users and groups.

4. Add files

Upload files from your computer or network to folders in wwSafe. Each time you upload the same file, you can 
create a new revision for the file. Each revision is given a sequential number and listed in the Revisions window. 

5. Accept group invitations

Accept or reject invitations to join groups. Invitations are shown in the Notification pane of your wwSafe window.

Groups let you easily share the same content with multiple users. Group members can share folders with you 
and you can share folders with the group. 

When you accept a group invitation, the group is added to the list of Groups in your Groups window. The user 
who invites you to the group gives you permissions that determine what actions you can perform for the group. 

Groups are created by wwSafe Security Administrators. You can ask a wwSafe Security Administrator to create 
any groups you need. Also ask them to invite you to join the groups and give you Share and Modify permissions 
(the highest permissions level for groups) so that you can invite other users to join the group.
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 Tip: To see your groups and permissions, click the  button. Then double click the name of 
the group in the Groups window. If members and permissions are not shown when you click on a group, this 
means you have Share with Group permissions. This is the lowest level of group permissions.

6. Share folders

Share folders with one or more individual users, one or more groups, or a combination of users and groups.  
When you share a folder:

 An invitation to share is sent to the users and/or groups you select. If a user or group member accepts  

the invitation, the folder is added to their wwSafe window.

 You give a user or group permissions for the folder and its content. For example, you might allow all  

sharing users to view folder content but only one sharing user to add files. Sharing with individual users 
allows you to assign different folder permissions to different users. All members of a group have the 
same permissions.

 All files and subfolders contained in the folder are shared. Changes to folder content are also shared.  

For  example,  when a file  or subfolder  is  added to  the folder, all  sharing users see the new file  or  
subfolder. When a file is renamed, all sharing users see the new name.

Note: After at least one invitee accepts a folder sharing invitation from you, the shared folder is marked in 

your wwSafe window with a blue sharing symbol  . It is marked in the window of the other user with a yellow 

sharing symbol  .

7. Accept folder sharing invitations

Accept  or  reject  invitations to  share folders.  Invitations are shown in  the Notification pane of  your  wwSafe 
window.

When you accept a folder sharing invitation, the folder is added to the Cabinet you select and is shown in your 
wwSafe window.

The user who invites you to share a folder gives you or your group permissions that determine what actions you 
can perform for the folder and its files. 

 Tip: To see your permissions for a folder, click on the folder and select Permissions from the Sharing menu. 

WWPass wwSafe Version 2.1 User Guide 11/10/14

13 of 84



WWPass wwSafe User Guide

Starting wwSafe

Overview

This topic provides an overview for running wwSafe. 

The main steps are to start the wwSafe client, connect to a wwSafe server, and authenticate your identity with 
your PassKey. The main wwSafe window then opens. This contains your wwSafe Cabinets with folders and files.

The first time you run wwSafe, you need to add a wwSafe server to your server list and register your PassKey 
with the server. 

 Click here for the steps to add a wwSafe server and register with the server.

 Click here for the steps to connect to an existing wwSafe server.

Present Your PassKey

In  order  to  start  and  use  wwSafe,  you  need  to  present  your  PassKey  to  your  computer.  Your  PassKey 
authenticates your identity, ensuring only you can access your Cabinets and their content. 

Each time you authenticate with your PassKey, the WWPass Authentication Request that asks if you want to  

allow authentication appears. Click  to continue.

If your wwSafe server requires authentication with the access code for your PassKey, you will be asked to enter 
it in the WWPass Access Code Request dialog.
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If your PassKey is not presented to your computer, a message prompts you to connect or insert your PassKey. 
Present your PassKey. The message is cleared.

If you remove your PassKey while wwSafe is running, you are automatically logged out and the No PassKey 
message appears.

The Server Disconnected message appears if your connection is interrupted by an Internet or system issue.

Click  to clear either message. The initial wwSafe window opens.

If you want to log into wwSafe again, click  and authenticate your identity with your PassKey. If you 
want to exit from wwSafe, click the X button at the top of the window.

Add a wwSafe Server and Register your PassKey

Follow the steps below to run the wwSafe client and connect to a new wwSafe server. To run wwSafe with an  
existing server, click here. 

Major steps are to:

1. Add a wwSafe server to the list of servers you can connect to from the wwSafe client. To add a server, 
you need the server address (e.g., wwsafe.mycompany.net or 10.10.10.101) and the port number used 
for  wwSafe.  The  default  is  443.  Address  and  port  number  are  provided  by  a  wwSafe  Security  
Administrator.

2. Register your PassKey with the wwSafe server. To register, you log into wwSafe with the credentials 
provided by a wwSafe Security Administrator or WWPass cloud domain admin. You only need to enter 
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credentials once for a wwSafe server. Each subsequent time you connect to that server, you log in with 
only your PassKey or PassKey and its access code, depending on your organization's requirements.

To add a new server:

1. Present your PassKey to your computer. 

2. Start wwSafe from the Windows Start Menu or the Desktop shortcut. The login window opens.

3. Add a wwSafe server as follows:

a. Click the Servers button  to open the Servers dialog. The Servers window opens.

  

b. Click the Add Server button . Enter the address for your wwSafe server, for example: 
wwsafe.mycompany.com.
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c. Enter the number of the port used for wwSafe on the server host, for example 443.

 

d. Click    to save your settings.

e. Click  to close the Servers window. The initial wwSafe window appears with your 

wwSafe server shown in the server list: .

If required, you can later add another server or modify existing ones. For details, click here. 

To register your PassKey with the wwSafe server:

1. From the login window, open wwSafe by clicking .

2. Click  in the WWPass Authentication Request that asks if you want to allow authentication 
into your wwSafe server.

3. Enter the access code for your PassKey in the WWPass Access Code Request dialog if required and 

click .

4. When the Create User dialog opens, enter your credentials. Then click .

5. The registration process can take some time. When your PassKey is registered with your wwSafe server 
the main wwSafe window opens.

WWPass wwSafe Version 2.1 User Guide 11/10/14

17 of 84



WWPass wwSafe User Guide

Run wwSafe and Connect to an Existing Server

Follow the steps below to run the wwSafe client with an existing wwSafe server. This is a server you have added  
to your server list and registered your PassKey with.

Click here if you want to run the wwSafe client with a new wwSafe server – one that has not been added to your 
server list.

To run wwSafe:

1. Present your PassKey to your computer. 

2. Start wwSafe from the Windows Start Menu. The login window opens.

3. Select the wwSafe server to log into from the servers list . 

The last server you logged into is shown by default. If you have added multiple servers to the list, you  
can click in the list and select a different server. (If you have not registered your PassKey with a server  
yet, you are prompted for the credentials provided by a wwSafe Security Administrator or a WWPass  
cloud domain administrator.)

4. Open wwSafe by clicking . 

 Note: If your PassKey is not presented to your computer, a message prompts you to connect or  
insert your PassKey. Present your PassKey. The message is cleared. You do not need to click Cancel  
unless you want to cancel running wwSafe or select a different wwSafe server to log into.

5. Click  in the WWPass Authentication Request that asks if you want to allow authentication 
into your wwSafe server.

6. Enter the access code for your PassKey in the WWPass Access Code Request dialog if required and 

click . The main wwSafe window opens.
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Log Out and Exit from wwSafe

This topic covers logging out of and exiting from wwSafe:

 Logging out ends a wwSafe client session and closes the main client  window. The client continues 

running and you can log in again from the login window without restarting the client. You can:

o Log into the last wwSafe server accessed.

o Log into a different wwSafe server, if you have access to multiple servers. 

o Log in as a different user, if you are registered with a wwSafe server as multiple users. First, you 

need to present the PassKey for the different user. If your computer is shared, another wwSafe 
user can present their PassKey and log in.

 Exiting shuts down the wwSafe client and closes all client windows. You are automatically logged out.

 Important: If you log out of wwSafe and plan to leave your computer, be sure to remove your PassKey and 
take it with you. If your PassKey remains presented to your computer, someone else can access your Cabinets  
by clicking Enter button in the initial wwSafe window.

To log out of wwSafe:

Do one of the following:

 Click Log Out from File menu in wwSafe's main window. The main window closes and the login wwSafe  

window opens.

 Remove your PassKey from your computer. The "No PassKey" message appears. Click   to 

clear the message. The login wwSafe window opens.

 Tip: To log in after logging out, click  in the initial wwSafe window and authenticate your identity 
with your PassKey. The main wwSafe window opens.
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To exit from wwSafe:

Do one of the following:

 Click the X button at the top of the main wwSafe window or the login window.

 Click Exit from the File menu in the wwSafe main window if you are logged in.

 Press Alt+F4.
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Introducing the Main wwSafe Window

The main wwSafe window opens after you log into a wwSafe server and authenticate your identity with your  
PassKey.

The main window contains the Notification pane, the display buttons, and two panes for Cabinets, folders and  
files. The left pane shows how a Cabinet and its folders are organized. The right pane shows the content of a  
Cabinet and its folders.

Open a Cabinet

Follow the steps below to open a wwSafe Cabinet and display its content. The content includes folders and any  
files stored at the Cabinet level (not inside a folder).

1. Click on a Cabinet in the left pane.

2. The Cabinet's folders and files are shown in the right pane (content pane).

WWPass wwSafe Version 2.1 User Guide 11/10/14

21 of 84



WWPass wwSafe User Guide

Open Folders

Follow the steps below to open a folder and display its content. The content can include files and subfolders. 

1. Click on a folder in the left pane or ...

Double-click on the folder in the right pane.

2. The folder's files and subfolders are shown in the right pane (content pane). For each file, information 
includes the date it was added to a Cabinet, the date it was last modified (meaning a new revision was 
added), size of the newest revision, and total number of revisions. 

Right Pane Display Features

Display features let you control how information is displayed in the right pane (content pane) and Notification 
pane of your wwSafe window.

  Click the Refresh button to update the left and right panes. 

  Click the Show as Icons button to display icons for folders and files in the right pane.

This contains only the icons of folders and files and their names. 

WWPass wwSafe Version 2.1 User Guide 11/10/14

22 of 84



WWPass wwSafe User Guide

  Click the Show Details button to display detailed information for folders and files in the right pane.

This contains the detailed information about folders and files:

Column Information Shown

Name This is the name of a file or a folder. The name of its source file is used by default in  
wwSafe. You can change a file name in wwSafe if you have sufficient permissions for the 
file's folder. Changing a file's name in wwSafe does not change the name of its source  
file. Files are listed in alphabetic order by name in the right pane.

Created This is the date and time a file or a folder was first added to wwSafe.

Modified This is the date and time a folder was modified or a file was last added to wwSafe.

Size (files only) This is the size of the last revision of the file added to wwSafe.

# of Revisions 
(files only)

This is the number of revisions of the file added to wwSafe. Each file has at least one 
revision.

Notification Display Features

The Notification Pane displays the messages about sharings and invites you get in wwSafe.

Click the Update Notifications button  or select Update from the Notifications menu to see new 
notifications that are sent as you use wwSafe.

Groups Feature

Button  opens the Groups window. The detailed description of groups functionality can be 
found below. 
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Data storage in wwSafe: for Cabinets, Folders and Files

The  main  storage  components  shown  in  wwSafe  are  Cabinets,  folders,  and  files.  These  are  shown  in  a 
hierarchy, with a Cabinet at the top level and folders and files below it.

Cabinet  

A Cabinet can be thought of as a virtual drive (the equivalent of 
your c:\ drive) or electronic container that securely holds your 
folders and files in cloud storage. Your cabinets are created and 
assigned to  you  by  a  wwSafe  IT Manager.  The  IT Manager 
determines the amount of storage space in each Cabinet.

Folders  

You can  create folders  and  subfolders  to  organize  files  in  a 
Cabinet.  These  descend  from  the  Cabinet  in  a  hierarchical 
folder tree.  Folders can be  shared with other wwSafe users. 
When a folder is shared, all the files and sub-folders it contains 
are also shared. 

Files  

You can  add files to a Cabinet  by uploading them from your 
computer  or  network.  The  files  can  be  in  any  format,  for 
example, Microsoft Word or Excel. When you upload a file, its 
data is encrypted and can only be accessed with your PassKey. 
The first time a file is uploaded, its first revision is created. Each 
time  a  file  is  uploaded  after  that,  another  revision  can  be 
created.

Files can be shared with other users when they are stored in 
folders. To share a file, you share its folder. All revisions of the 
file are shared. 

Files  cannot  be  opened  in  wwSafe.  If  you  want  to  view  or 
modify  files,  open  their  source  files  from  your  computer  or 
network. If the source file for a shared file is not available on 
your computer, you can export it from wwSafe to your computer. 
After you modify a file, you can add it to wwSafe again.
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Cabinets

Rename a Cabinet

This topic covers renaming Cabinets in wwSafe.

Renaming a Cabinet does not affect its content. When you rename a Cabinet that is assigned to other users, the  
name change is only shown in your wwSafe window. It is not shown for other users.

There is no limit to the length of Cabinet names. There are also no restrictions in special characters you can use  
for the names of Cabinets. 

Permissions needed

You do not need special permissions to rename a Cabinet.

To rename a Cabinet:

1. Select a Cabinet by clicking on its name in the left pane.

2. Select Rename... from the Edit menu or right-click on the Cabinet name and select  Rename...  from a 
pop-up menu or press F2 on your keyboard.

   

3. The “Rename” window opens. Enter a new name for the Cabinet and click . 

4. The new name is shown in wwSafe.

Delete All Cabinet Content

This topic covers "cleaning up" a Cabinet. 

You should only clean up a Cabinet when you are certain you no longer need its content in wwSafe.

Cleaning up a Cabinet deletes all the folders, subfolders, and files it contains. They are no longer available in 
wwSafe. Cleanup does not delete the Cabinet itself. Also, it does not delete groups or notifications.

If the Cabinet contains folders that were shared by you, sharing users can still see the folders after your cleanup,  
but folder content is no longer available. The folders are shown with the red symbol of cancellation.
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If other users still need access to a shared folder you own, assign ownership to a different user before you clean 
up a Cabinet. The folder will then remain available to all sharing users.

 Note: The Clean Up feature is useful in scenarios where a Cabinet was used for one purpose (such as a  
certain project) and you now want to use it for another purpose. With a single operation, this feature lets you 
remove  all  content  that  is  no  longer  needed.  This  saves  the  time  and  effort  involved  in  deleting  folders  
individually.

Permissions needed

You do not need special permissions to delete all contents of a Cabinet.

To delete all Cabinet content:

1. Select a Cabinet by clicking on its name in the left pane.

2. Select Clean Up Cabinet from the Edit menu or right-click on the Cabinet name and select Clean Up 
Cabinet from a pop-up menu. (The Clean Up feature is available when a Cabinet is selected.)

   

3. When a message asks if you want to continue, respond as follows:

 Click this button if you are sure you want to delete all content from the Cabinet. All folders and files 
are removed. 

 Click this button if you want to preserve all content in the Cabinet.

 Important: A Cabinet cannot be cleaned up if an upload or a download are active in your wwSafe. If you try 
to  clean  up  the  Cabinet  at  this  moment,  the  information  message  is  shown.  Wait  till  the  active  
uploads/downloads are finished or cancel them to clean up the Cabinet.
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Cabinet about information

This topic covers viewing the information about a Cabinet. 

Permissions needed

You do not need special permissions to view information about a Cabinet.

To delete all Cabinet content:

1. Select a Cabinet by clicking on its name in the left pane.

2. Select Cabinet Details from the File menu. (The Cabinet details feature is available when a Cabinet is  
selected.)

3. The Cabinet Information window opens. 

The window contains the following information:

 Used size – The size of files which are stored in the Cabinet

 Total size – The size limit for this Cabinet

 Storage – The information about the storage (can be useful for Security Administrators)

4. Click    to close the window.
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Cabinet History

This topic covers auditing the changes made for a Cabinet, its subfolders, and files.

Changes are shown in the Cabinet History window. This lets you track the operations that were performed for a  
Cabinet, who performed them, and when they were performed. 

Permissions needed

You do not need special permissions to audit a Cabinet’s History.

To open a Cabinet’s history:

1. Select a Cabinet by clicking on its name in the left pane.

2. Select  Cabinet History… from the File menu or right-click the Cabinet and select  Cabinet History… 
from the pop-up menu.

   

3. Choose whether you want to open the whole history or history for the certain dates in the next window 

and click .
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4. If you chose “History by dates”, select the dates in the “Choose dates” window. To navigate between the 

months use green buttons with arrows . Click 

5. The “Cabinet History” window will be displayed as follows:

The Cabinet history window fields are the same as the Folder history window. The detailed description of all the 
fields can be found at the Folder history window description. 
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Folders

Create a Folder

This topic covers creating folders and subfolders in a wwSafe Cabinet. 

After you create a folder, you can add files and subfolders to that folder, and share the folder with other wwSafe 
users. All the files and subfolders contained in the folder are automatically shared with users sharing the folder. 

Permissions needed

You do not need special permissions to create folders directly below a Cabinet. 

You can create subfolders in a folder if you are the folder owner or have one of the following permissions levels 
for the folder: Contribute, Edit, Edit and Audit, or Share. 

To create a folder in wwSafe:

1. Select a Cabinet where the folder should be stored by clicking on the Cabinet in the left pane. If the  
folder will be a subfolder, select its parent folder by clicking on that folder name in the left or right pane.

2. Select New Folder... from the Edit menu or right-click on the empty space in the right pane (a Cabinet or 
parent folder should be opened) and select  New Folder... from the pop-up menu. (The New Folder 
feature is available when a folder or Cabinet is selected.) 

   

3. The Create Folder dialog opens. Type a name for the new folder in the Create Folder dialog and click  

. The folder is created.

Check your wwSafe window to see the new folder in the selected Cabinet or folder.
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Rename a folder

This topic covers renaming folders in wwSafe.

Renaming a folder does not affect its content. 

When you rename a folder that is not shared or is shared with other users, the name change is only shown in 
your wwSafe window. When you rename a subfolder in a folder that is shared, the subfolder's new name is  
shown for all sharing users.

There is no limit to the length of names in wwSafe. There are also no restrictions in special characters you can  
use for the names of folders. 

Permissions needed

You do not need special permissions to rename a folder you own.

If a subfolder is in a folder that was shared with you, you can rename the subfolder and its files if you have one 
of the following permissions levels for the shared folder: Edit, Edit and Audit, or Share.

To rename a folder:

1. Select the folder you want to delete by clicking on it in the left or right pane.

2. Select  Rename... from the Edit  menu or right-click on the folder in the left  or right pane and select  
Rename... from a pop-up menu or press F2 on your keyboard. 

   

3. The “Rename” dialog opens. Enter a new name for the folder and click  . The new name is 
shown in wwSafe.
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Move a Folder

This topic covers moving folders within wwSafe.

Folders can be moved within a Cabinet. When a folder is moved, all the subfolders and files it contains are  
moved with it. 

If you move a shared folder, it remains in the windows of other sharing users and its content is still available to 
them. If you move a subfolder of a shared folder to a folder which is not shared, it is removed from the windows 
of sharing users.

 Note: Folders cannot be moved to another Cabinet. 

 Note: You cannot move a folder if you have selected it to view its files or subfolders in the right pane. Go to 
the upper level of the folder tree to move the folder.

Permissions needed

You can move a folder if you are the owner or the folder was shared with you. 

If you want to move a subfolder from a shared with you folder, you can do this if you have one of the following  
permissions levels for the shared folder: Edit, Edit and Audit, or Share.

To move a folder within a Cabinet:

1. Select the folder you want to move by clicking on it in the left or right pane.

2. Select Move... from the Edit menu or right-click on the folder name in the left or right pane and select  
Move... from a pop-up menu. (The Move feature is available when a folder is selected.)

   

3. The “Choose Folder” window appears. Select the destination Cabinet or folder from the folders list and 

click .

Alternatively, you can drag the folder you want to move and drop it in the destination Cabinet or folder.

4. Check your wwSafe window to see the folder in the destination Cabinet or folder.
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Delete a Folder

This topic covers deleting folders from wwSafe.

When you delete a folder, it is removed from your wwSafe window. All the files and subfolders it contains are  
also removed.

The result of the deletion of a shared folder depends on whether the folder was shared with you or by you:

 If you delete a folder that was shared with you, it remains in the windows of other sharing users and its  

content is still available to them. 

 If you delete a folder that was shared by you, it remains in the windows of sharing users but its content is 

no longer available to them. The folder is shown with the red symbol of cancellation. 

 If you delete a subfolder from a shared folder (one shared with you or by you), the subfolder is removed 

from the windows of sharing users.

 If another user deletes a shared folder, it is still shown in your wwSafe window, but its content is no 

longer available. The folder is shown with the red symbol of cancellation. Because folder content is no 
longer available, you might want to delete the folder from your wwSafe window.

 Note: You cannot delete a folder if you have selected it to view its files or subfolders in the right pane. Go to 
the upper level of the folder tree to delete the folder.

 Important: Only delete a folder when you are certain that you no longer need the folder and its files in  
wwSafe. If you delete a folder by mistake, you can recreate the folder and add files again. But only the newest 
revision of  each file  will  be available in wwSafe.  Older  revisions cannot be restored.  To restore access for  
sharing users, share the folder again with those users.

Permissions needed

You can delete a folder if you are the owner or have one of the following permissions levels: Edit, Edit and Audit, 
or Share. 

If you want to delete a subfolder from a shared folder, you can do this if you have the permissions above for the  
shared folder.

To delete a folder from wwSafe:

1. Select the folder you want to delete by clicking on it in the left or right pane.

2. Select Delete... from the Edit menu or right-click on the folder name in the left or right pane and select  
Delete... from a pop-up menu or press Delete on your keyboard. (The Delete feature is available when a 
folder is selected.)

   

3. Click  in the message that asks if you are sure you want to delete the folder. The folder and its  
subfolders and files are removed from your wwSafe window.
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Audit a Folder's History

This topic covers auditing the changes made for a folder, its subfolders, and files.

Changes are shown in the Folder History window. This lets you track the operations that were performed for a  
folder, who performed them, and when they were performed. 

Permissions needed

You can view and audit a folder's history if you are the folder owner or have one of the following permissions for 
the folder: View and Audit, Edit and Audit, or Share. 

If a subfolder is in a shared folder, you can audit the subfolder's history if you have sufficient permissions for the 
shared folder.

If you do not have sufficient permissions for a folder, the Permission denied message appears when you select  
the Folder History feature.

To open folder history:

1. Select the folder by clicking on it in the left or right pane.

2. Select Folder History... from the File menu or right-click on the folder name in the left or right pane and 
select Folder History... from a pop-up menu. (The Folder History feature is available when a folder is 
selected.)

   

3. Choose whether you want to open the whole history or history for the certain dates in the next window 

and click .
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4. If you chose “History by dates”, select the dates in the “Choose dates” window. To navigate between the 

months use green buttons with arrows . Click 

5. The “Folder History” window will be displayed as follows:
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Columns in the Folder History Window

Columns in the Folder History window show the following information:

Column Information Shown

Time This is the date and time an operation was performed or attempted for a Cabinet. 

Operation This is the operation that was performed or attempted for a folder. The following operations can 
be shown:

 A subfolder was created – Shown when a subfolder is created in a folder.

 A file was created in this folder* – Shown the first time a file is uploaded to a folder.

 A new revision was created* – Shown when a revision of a file is uploaded (added) to a 

folder. This can be the first revision or a later revision.

 A file has been uploaded* – Shown when a revision of a file is uploaded to a folder. This 

can be the first revision or a later revision.

 The file upload was canceled – Shown when a file upload is canceled. 

 A file was uploaded and the revision was finished* – Shown when a revision of a file is 

uploaded successfully to a folder. This can be the first revision or a later revision.

 A file has been downloaded – Shown when a revision of a file is downloaded from the 

folder. 

 A subfolder was removed – Shown when a subfolder is deleted from a folder.

 A file or a subfolder was removed – Shown when a folder or file is deleted from a folder.

 One or several revisions were removed – Shown when revisions of a file are removed

 A file or a subfolder was renamed – Shown when a folder or file is renamed in a folder.

 A sub-folder was added as a result of sharing – Shown when a sharing was accepted to 

this folder. 

 A file or a sub-folder was moved from this folder – Shown when a file or a subfolder was 

moved to another folder.

 A file or a sub-folder was moved to this folder – Shown when a file or a subfolder was 

moved from another folder to this folder. 

 The access rights for this folder were changed – Shown when:

o The  folder  was  shared  with  another  user  and  the  other  user  accepted  the 

invitation, or the folder was shared with a group.

o Folder permissions were changed for a user or group.

o Folder ownership was changed.

* All four operations marked with an asterisk are shown for a file the first time it is uploaded to a  
folder. All have the same time stamp. Three of these operations are shown for the file each time 
a revision is uploaded. The operation that is not shown is "A file was created in this folder".
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Path This is the name of the file that was uploaded, downloaded, renamed or deleted. It can also be 
the name of a subfolder that was created or deleted. A name is not shown if a subfolder was 
renamed.

Type Indicates whether a file or a folder was involved in the operation. 

Author For most operations, this is the user who performed or attempted an operation. For sharing-
related operations, the name of another user is shown:

 If a folder was shared, this is the user who shared the folder.

 If folder permissions were changed, this is the user who changed them.

 If folder ownership was changed, this is the new owner.

Result This indicates whether an operation was successful.

 Succeeded is shown if an operation was successful.

 Failed is shown if an operation failed.

 Denied is shown if an operation is denied.
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Files

Add a File to wwSafe

This topic covers adding files to wwSafe.

Files can be in any format. The only limit to file size is the amount of storage space allocated to the Cabinet a file  
is added to. If a wwSafe message says you have run out of space, contact a wwSafe IT Manager.

Adding a file uploads (copies) it from your computer or network. How long this takes depends on the size of the  
file and the internet connection. Larger files or low internet speed take longer.

If you log out when uploading of a file is not finished yet wwSafe will pause the uploading process and restore it 
when you log in again.

The same file can be added to wwSafe as many times as needed. For example, you might want to add a file  
again each time you change its content. When you add the same file to the same folder in wwSafe, you are  
asked if you want to create a new revision. If a file's name is changed before you add it again, it is treated as a 
new file and its first revision is created.

 Note: If a file is in a shared folder, the file and all its revisions are shared.

Permissions needed

You can add files to a folder if you are the owner of this folder or have one of the following permissions levels for 
the folder: Contribute, Edit, Edit and Audit, or Share. 

If you want to add files to a subfolder in a shared folder, you can do this if you have the permissions above for  
the shared folder.

To add a file to wwSafe:

1. Select the folder or a Cabinet where the file should be stored by clicking on it in the left or right pane.

2. Select  Add File... from the File menu or right-click on the folder name and select  Add File... or right-
click at the empty space in the right pane and select Add File... (The Add File feature is available when 
a folder or Cabinet is selected or opened.) 

   

3. The  Upload file  window opens.  Find the  file  you want  to  add  to  wwSafe,  select  the file,  and click 

. 

Alternatively, you can drag the file from your PC and drop it in the destination Cabinet or folder.
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4. If the file already exists in the selected folder, a message asks if you want to create a new revision:

a. Click  if you want to create a new revision in the selected folder.

b. Click  if you do not want to create a new revision. You can add the file to a different 
folder or change its name and upload it as a new file to the same folder or a different one.

5. The file uploading starts. During upload, you can check the upload progress in the “Current Uploads and 
downloads” window.

6. When the upload process is finished, the Upload result message is shown:

Check wwSafe to see the file and its revision: Click the file's folder to open it and display the file in the right  
pane. Check to see information such as date added, size of the latest revision, and number or revisions. 

Export a File from wwSafe

This topic covers exporting files from wwSafe.

Exporting a file downloads (copies) it to your computer or network. You can then open the file in order to view its  
content.

The Export feature is especially useful for files that were shared with you by other users. Typically, these files are 
not available for viewing from your computer until you export them.

When you export a file, the newest complete revision of a file is exported. If you want to export an older revision, 
you can do it from the “Revisions Information” window.

You do not need to export a file before making changes if the file is not shared. If its source file is available on  
your computer, you can simply make changes to the source file and then  add it again to wwSafe as a new 
revision. 
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You might want to export a file before making changes if the file is shared with other users who can make  
changes. In this case, you might want to export the newest revision. This ensures that your changes and those  
of other users are included in the same revision when you add the file again to wwSafe.

 Note: If a file by the same name already exists in the folder, you need to remove it before starting download. 

 Note:  A file can be exported only if the upload of it was finished at least once. If  there are not finished  
revisions, the following message is shown: 

Permissions needed

You do not need special permissions to export a file.

To export the last revisions of a file:

1. Select the file by clicking on its name in the right pane.

2. Select  Export...  from the File menu or right-click on the file name and select  Export...  (The Export 
feature is available when a file is selected.) 

   

3. From the “Download File” window, select a folder on your computer or network for the exported file and 

click . The file is exported to the selected folder. 

Alternatively, you can drag the file from wwSafe and drop it in the destination folder on your PC.

4. When the export process is finished, the Download result message is shown:
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Rename a File

This topic covers renaming files in wwSafe.

Renaming something does not affect its content. Renaming a file does not change the name of the source file on  
your computer or network.

When you rename a file in a folder that is shared, the file's new name is shown for all sharing users.

There is no limit to the length of names in wwSafe. There are also no restrictions in special characters you can  
use for the names of files. However, the following special characters are not allowed when you export a file (as 
Windows does not allow these characters in file names):

 < less than

 > greater than

 : colon

 " double quote

 / forward slash

 \ back slash

 | vertical bar or pipe

 ? question mark

 * asterisk

Permissions needed

You can rename the files in a folder if you are the folder owner or have one of the following permissions levels 
for the folder: Edit, Edit and Audit, or Share. 

To rename a file:

1. Select the file by clicking on its name in the right pane.

2. Select Rename... from the Edit menu or right-click on the file and select Rename... from a pop-up menu. 

   

3. The Rename dialog opens. Enter a new name for the file and click . The new name is shown in 
wwSafe.

WWPass wwSafe Version 2.1 User Guide 11/10/14

41 of 84



WWPass wwSafe User Guide

Move a File

This topic covers moving files within wwSafe.

Files can be moved within a Cabinet. When a file is moved, all its revisions are moved with it. 

If you move a file from shared folder to a folder which is not shared, it is removed from the windows of sharing  
users.

 Note: Files cannot be moved to another Cabinet. 

Permissions needed

You can move a file if you are the owner of a folder where this file is stored or you have one of the following 
permissions levels for this folder: Edit, Edit and Audit, or Share.

To move a file within a Cabinet:

1. Select the file by clicking on its name in the right pane.

2. Select  Move... from the Edit menu or right-click on the file name and select  Move... from a pop-up 
menu. (The Move feature is available when a file is selected.)

   

3. The “Choose Folder” window appears. Select the destination Cabinet or folder from the folders list and 

click .

Alternatively, you can drag the file you want to move and drop it in the destination Cabinet or folder.

4. Check your wwSafe window to see the file in the destination Cabinet or folder.
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Delete a File from wwSafe

This topic covers deleting files from wwSafe.

When you delete a file, all revisions of the file are removed:

If the file is in a folder that is not shared, the file and its revisions are only removed from the folder in your  
wwSafe window.

If the file is in a folder that is shared, the file and its revisions are removed from that folder for all sharing users,  
including you.

 Important: Only delete a file when you are certain that you and any sharing users no longer need the file in  
wwSafe. When a file is deleted, its revisions are no longer available in wwSafe. If you delete a file by mistake,  
you can add the file again. But only the newest revision of the file will be available in wwSafe. Older revisions 
cannot be restored.

Permissions needed

You can delete files from a folder if you are the owner or have one of the following permissions levels for the 
folder: Edit, Edit and Audit, or Share. 

To delete a file from wwSafe:

1. Select the file by clicking on its name in the right pane.

2. Select Delete... from the Edit menu or right-click on the file and select Delete... from a pop-up menu or 
press Delete button on your keyboard. (The Delete feature is available when a file is selected.)

   

3. Click  in the message that asks if you are sure you want to delete the file. The file and its 
revisions are cleared from your wwSafe window. 

View File Revisions

This topic covers viewing file revisions in wwSafe.

Each file has one or more revisions in wwSafe. The first time a file is added, its first revision is created. Every  
time you upload a file with the same name, a new revision is created.

You can view a list of all of a file's revisions in the “Revisions” window.

Permissions needed

You do not need special permissions to view file revisions.
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To view a file revision in wwSafe:

1. Select the file by clicking on its name in the right pane.

2. Select  Revisions...  from the File menu or right-click on the file  name and select  Revisions...  (The 
Revisions feature is available when a file is selected.) 

    

3. The “Revisions Information” window will be displayed as follows:

Columns in the Revisions information window

Columns in the “Revisions information” window show the following for each revision of a file:

Column Information Shown

# This is the sequential number assigned to a revision when it is added to wwSafe.

Created This is the date and time a revision upload to wwSafe was finished.

Size This is the size of a revision. If a revision did not finish uploading, it is the size of the uploaded  
part.

Author This is the user who added a revision. If multiple users upload the same file, multiple users are 
shown in the Author column.

Status This is the upload status of a revision:
 Finished is shown if upload completed successfully. The revision can be exported.

 Not finished is shown if upload did not complete successfully and cannot be continued. 

The revision cannot be exported.

 In progress is shown if uploading is going on right now. The revision cannot be exported.
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Export a file revision

This topic covers exporting file revisions from wwSafe.

 Note: A file revision can only be exported if it finished uploading successfully. If upload finished, Finished is 
shown for the revision in the Status column of the “Revisions information” window. 

Permissions needed

You do not need special permissions to export a file.

To export a file revision:

1. Select the file by clicking on its name in the right pane.

2. Select  Revisions...  from the File menu or right-click on the file  name and select  Revisions...  (The 
Revisions feature is available when a file is selected.) 

3. Right-click on the revision you want to export and select Export... (The Export feature is available when 
a revision is finished.) 

4. From the “Download File” window, select a folder on your computer or network for the exported file and 

click . The file is exported to the selected folder. 

5. When the export process is finished, the Download result message is shown. Click  to clear 
the message. 
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Delete a File revision

This topic covers deleting file revisions from wwSafe.

Permissions needed

You can delete revisions of a file if you are the owner of a folder containing it or have one of the following 
permissions levels for this folder: Edit, Edit and Audit, or Share. 

To delete a file revision from wwSafe:

1. Select the file by clicking on its name in the right pane.

2. Select  Revisions...  from the File menu or right-click on the file  name and select  Revisions...  (The 
Revisions feature is available when a file is selected.) 

3. Right-click on the revision you want to delete and select Delete.

4. Click  in the message that asks if you are sure you want to delete the selected revision. The  
revision is cleared from your “Revisions Information” window. 

Check uploads and downloads activity

When you upload or download a file, the process is hidden and you can do something else in wwSafe – e.g.  
create folders.

The upper pane of the main wwSafe window contains the indicator which shows whether the upload or download 
are active. The statuses of the indicator are as follows:

No uploads and downloads are active.

One or more uploads are active. 

One or more downloads are active. 

At least one upload and at least one download are active. 
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View current uploads and downloads

This topic covers viewing current uploads and downloads in wwSafe.

You can see  the progress of  the current  uploads  and downloads in  the “Current  uploads  and  downloads”  
window. 

Permissions needed

You do not need special permissions to view current uploads and downloads.

To view current uploads and downloads:

1. Select Uploads/downloads... from the File menu or click on the Upload/Download Status button in the 
upper pane of the main wwSafe window.

   

2. The  “Current  uploads  and  downloads”  window appears.  All  the  active  uploads  and  downloads  are  
presented there. When an upload or download is finished, the appropriate line disappears from the table.  

If the window is empty, no uploads and downloads are active. Click  to clear the window.

 

Columns in the “Current uploads and downloads” window

Columns in the “Current uploads and downloads” window show the following for each upload and download:

Column Information Shown

Process This shows whether a file is uploaded or downloaded:  means upload,  means download

File This is the name of a file.

Progress This is the current progress of the operation.
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Cancel current upload or download

This topic covers canceling current uploads and downloads in wwSafe.

Canceling uploads or downloads can be helpful when you do not need this upload or download any more, e.g.  
you started it by mistake or need some free space for another upload.

When an upload is canceled,  the part  of the revision which was uploaded by that  moment is deleted from 
wwSafe, and the revision is no longer available in the “Revisions” window. If the file had only one revision, the 
file is deleted as well. The local file which was uploaded is not changed. 

When a download is canceled, the unfinished local file is deleted. The file in wwSafe is not changed. 

You can cancel current uploads and downloads in the “Current uploads and downloads” window. 

Permissions needed

You do not need special permissions to cancel current uploads and downloads.

To view current uploads and downloads:

1. Select Uploads/downloads... from the File menu or click on the Upload/Download Status button in the 
upper pane of the main wwSafe window.

2. The “Current uploads and downloads” window appears. Select one upload or download there by clicking 

on it and click .

 

3. Click  to submit cancel in the “Cancel uploads/downloads” window. 

Check that the canceled process disappeared from your “Current uploads and downloads” window.
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Groups

Overview for Groups

Groups provide an easy way to share folders with multiple users who need access to the same information. 

When a folder is shared with a group, all group members have access to the files and subfolders it contains. 
Sharing with a group saves the time involved in sharing with users individually. 

Each member of a group can share folders with the group. In addition, each member receives all folder sharing 
invitations sent to the group. These include any invitations that were sent before they joined the group. The 
member list is the equivalent of a distribution list for folders shared with the group.

When you share a folder with a group, you can assign permissions for the folder and its files. Folder permissions 
are the same for all group members.

The “Groups” window lists the groups you belong to and any groups you own (if group ownership was assigned 
to you). The window also provides features for managing groups. Click on the Groups button or select Manage 
groups… from the Organize menu to open the Groups window.

Features in the “Groups” window

The “Groups” window let you (if you have appropriate permissions level):

 View groups list

 Create groups

 View member lists and group permissions

 Delete groups

 Change group permissions 

 View group history

 View invites and shares for a group

 Note: Group name and group owner cannot be changed from the wwSafe client. If you need to do either,  
contact a wwSafe Security Administrator.
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How groups are created

Groups are created by wwSafe Security Administrators. An administrator invites the first user or users to join and 
gives them permissions for the group. 

When you need a group for sharing folders, send a request to a Security Administrator and provide the name to  
use for the group (for example, Legal), a brief description of its purpose (for example, to share folders for legal  
documents with corporate attorneys), and a list of users to invite to the group.

If  the Security  Administrator  gives  you  Share and Modify  Members permissions  for  the  group  (the highest 
permissions level), you can invite users to join the group. If they give you a lower permissions level, the Security  
Administrator needs to invite other users to join based on the list you provide.

 Note: Initially, the Security Administrator who creates a group is the group owner. If it is not necessary or 
appropriate for the Security Administrator to see the folders and files shared with the group, they can make you 
or another group member the owner of the group. The Security Administrators can then remove themselves from 
the group.

Join a group

This topic covers joining groups.

You can join a group when you receive an invitation to a group. If you accept the invitation, the group is added to 
the list in your “Groups” window. 

When you accept a group invitation, you become a member of the group and the group is added to the list in 
your Groups window. What actions you can perform for a group depends on the permissions level assigned by 
the user who invited you to join.

Permissions needed

You do not need special permissions to join a group you are invited to.

To join a group:

1. Check the notification pane of the main wwSafe window. Invitations to join groups appear there when 
they are received. 

2. Accept a group invitation using the checkmark button  in the Notification pane.

3. Click  to clear the "Group invitation was accepted" message.

When you accept a group invitation, you receive all folder sharing invitations that are sent to the group. These  
include any invitations that were sent before you joined the group. The latter are shown in the Notification pane 
after accepting the invitation.
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Delete a group

This topic covers deleting groups from wwSafe. 

When a group is deleted, the following happens:

 The group is removed from the Groups window of the group owner and all group members.

 Group members  no  longer  have  access  to  folders  shared  with  the  group.  The  folders  have  a red 

cancellation symbol in their wwSafe window and sharing symbols are removed.

 Folder-sharing invitations can no longer be sent to the group.

 Folder-sharing invitations that have not been accepted yet are removed from the Notification panes of 

group members.

Permissions needed

Only the owner of a group can delete a group.

To delete a group:

1. Select  Manage Groups... from the Organize menu or click   in the main wwSafe 
window. The Groups window opens with a list of groups you belong to or own. 

2. Click on the name of a group in the list to select the group and click the  button.

3. Click   in the message that asks if you are sure you want to delete the group. The selected 
group is deleted and removed from the Groups window of all group members.

4. Click  to close the “Groups” window.
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View group members

This topic covers viewing members of a group. 

Permissions needed

You can view a group member list if you are the group owner or have Share and View Members or Share and 
Modify Members permissions for the group.

To view members of a group:

1. Select  Manage Groups... from the Organize menu or click   in the main wwSafe 
window. The Groups window opens with a list of groups you belong to or own. 

2. Click  or double-click the group’s name. The “Group member list” window opens.

The window shows the name of the group,  the owner of the group, members in the group, and each 
member's access rights for the group. The owner of a group is shown in the Owner field. The owner's 
name is not included in the Members list.

3. When finished, click   to close the “Group members list” window.

4. Click  to close the “Groups” window.

Features in the “Group members list” window

The “Group members list” window let you (if you have appropriate permissions level):

 Add a member

 Modify permissions for a member

 Remove a member

 Remove all members
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Invite Users to Join a Group

This topic covers inviting users to join groups in wwSafe. 

Groups let you easily share folders with multiple people. When you invite users to join a group, think in terms of 
colleagues who need access to the same folders. For example, you might invite project managers to join a group  
that shares project folders.

You can invite users to join a group whenever needed. You might invite some users soon after a group is created 
and other users later on. When someone accepts a group invitation, they receive all folder sharing invitations 
that have already been sent to the group.

When you invite someone to join a group, you specify how long the invitation remains in effect and give them 
permissions for the group. Permissions can be different for each group member and can be changed as needed.

A user is added to a group if they accept an invitation before it expires. Their name is then shown in member list 
for the group. A user is not added if they reject an invitation or do nothing about the invitation before it expires. 

Permissions needed

You can  invite  members  to  join  a  group  if  you  are  the  group  owner  or  have  Share  and  Modify  Members 
permissions for the group.

To invite a user to join a group:

1. Select  Manage  Groups... from  the  Organize  menu  or  click  .  The  Groups 
window opens with a list of groups you belong to or own. 

2. Click on the name of a group to select the group. 

3. Click  or double-click the group’s name. The “Group member list” window opens.
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4. Click Add member button. The “Invite” window opens. (The Add member button is activated if you are 
the group owner or have Share and Modify Members permissions for the selected group.)

5. Click in the Select a person list and select the name of a wwSafe user. The list shows the names of all 
users whose PassKeys are registered with the wwSafe server. 

6. Enter an expiration time for the group invitation in the Invitation valid for: (hours) box. The default is 72  
hours. To be added to the group, the user must accept the invitation before the expiration time passes. 

7. Assign group  permissions to the user by clicking in the Access rights list and selecting a permissions 
level. The lowest permissions level (Share With Group) is selected by default.

8. Click  to send an invitation to the selected user. Then click  to clear the message 
that confirms the invitation was sent.

9. Repeat steps 4 through 8 for each additional user you want to invite to the group at this time. You can 
invite other users later.

10. Click  to close the “Group members list” window.

11. Click  to close the Groups window.

To see if a user accepted an invitation to join a group, check the “Group members list” window. The user's name 
is shown in the “Group members list” window if they accepted the group invitation before it expired. Also you can 

view the status of all the sent invites by clicking . 
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Modify Group Permissions

This topic covers changing a group member's permissions for a group. 

Permissions can be increased or decreased at any time. For example, you might want to give a member higher  
permissions so that they can modify the group. 

Permissions needed

You can change a group member's permissions if you are the group owner or have Share and Modify Members 
permissions for the group.

To change a group member's permissions for a group:

1. Select  Manage Groups... from the Organize menu or click  . The Groups window 
opens with a list of groups you belong to or own. 

2. Click  or double-click the group’s name. The “Group member list” window opens.

3. Double-click on the name of a group member. The “Modify rights” window opens with the member's 
current access rights for the group.

4. Change group permissions for the member by clicking in the Access rights list and selecting a different  
permissions level. Click here to see what each permissions level allows a member to do with the group.

5. Click  to save your change and close the Modify rights window. The new permissions level is  
shown in the “Group members list” window.

6. Click  to close the “Group member list” window.

7. Click  to close the “Groups” window.
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Remove a Member from a Group

This topic covers removing members from a group.

You can remove only some members of a group or all the members.

When a member is removed from a group, the following happens:

 The member's name is removed from the Group members list  of the group owner and other group 

members.

 The group is removed from the removed member's Groups window.

 The member no longer has access to folders shared with the group. The folders have a red cancellation  

symbol in their wwSafe window and sharing symbols are removed.

 The member no longer receives folder-sharing invitations that are sent to the group.

 Folder-sharing invitations that have not been accepted yet are removed from the member's Notification 

pane.

 Note: When a group is deleted, members do not need to be removed first. All are automatically removed 
from the group. 

Permissions needed

You can remove yourself from a group if you have Share and Modify Members permission level.

You  can  remove other  members  from a  group  if  you  are  the  owner  or  have  Share  and  Modify  Members 
permission level for the group. 

Group owners cannot remove themselves from a group.

To remove some members from a group:

1. Select Manage Groups... from the Organize or click .The Groups window opens 
with a list of groups you belong to or own. 

2. Double-click on the name of a group in the list or click the Members   button when the 
group is selected. The “Group members list” window appears.

3. Click on the name of a group member to select the member.
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4. Click . Then click  in the message that asks if you are sure you want to remove 
the member. The member is removed from the group.

5. Repeat steps 3-4 for each additional user you want to remove from the group.

6. Click  to close the “Group members list” window.

7. Click  to close the “Groups” window.

To remove all members from a group:

1. Select Manage Groups... from the Organize or click .The Groups window opens 
with a list of groups you belong to or own. 

2. Double-click on the name of a group in the list or click the Members   button when the 
group is selected. The “Group members list” window appears.

3. Click  . Then click   in the message that asks if you are sure you want to 
remove all the members. The members list is cleared.

4. Click  to close the “Group members list” window.

5. Click  to close the “Groups” window.
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Permissions for Groups

Permissions  determine  what  actions  a  group  member  or  owner  can  perform  for  a  group.  There  are  four 
permissions levels, including the owner level. Permissions can be different for each group member. 

The owner of a group automatically has all permissions for the group. They are the only user who can delete a 
group. (A group can be owned by a wwSafe Security Administrator or a wwSafe user. Initially, a wwSafe Security  
Administrator who created a group is the owner.)

Permissions are first assigned to group members when they are invited to join a group. They can be changed at 
any time by the group owner or by a member with Modify Members permissions for the group. 

 Note:  Permissions  can  be  checked from  the  “Groups”  window  by  users  with  one  of  the  following 
permissions: Share and View Members or Share and Modify Members. If you do not see permissions for group 
members, this means you have Share with Group permissions for the group.

Permissions Levels

The  table  below  shows  the  actions  allowed  for  each  permission  level  and  for  the  group  owner.  A green 
checkmark indicates an action is allowed. 

Actions Allowed 1 Share with 
Group

2 Share and 
View Members

3 Share and 
Modify 
Members

4 Owner

Share folders with a group ✔ ✔ ✔ ✔

View member list for a group; view group 
permissions of other group members; audit 
history of changes to a group

✔ ✔ ✔

Modify permissions of other group 
members; invite members to the group; 
remove members from the group

✔ ✔

Delete a group ✔
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Audit a Group's History

This topic covers auditing the changes made for a group and its members.

Changes are shown in the “Group History” window. This lets you track the operations that were performed for a  
group, who performed them, and when they were performed. 

View the Group History

Permissions needed

You can view a group member list if you are the group owner or have Share and View Members or Share and 
Modify Members permissions for the group.

To open the Group History

1. Select Manage Groups... from the Organize or click .The Groups window opens 
with a list of groups you belong to or own. 

2. Click on the name of a group to select the group and click .

3. Choose whether you want to open the whole history or history for the certain dates in the next window 

and click .

4. If you chose “History by dates”, select the dates in the “Choose dates” window. To navigate between the 

months use green buttons with arrows . Click 
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5. The “Group History” window will be displayed as follows:

6. Click  to clear the window.

Columns in the “Group History” Window

Columns in the “Group History” window show the following information:

Column Information Shown

Time This is the date and time an operation was performed or attempted for a group. Group history is 
sorted by time, from newest to oldest, with oldest at the top.

Operation This is the operation that was performed or attempted. The following operations can be shown:

 A new user was added—Shown when a group is created or a user accepts an invitation 

to join a group.
 A user was removed—Shown when a user is deleted from a group.

 The group permissions were changed—Shown when a user's permissions for a group 

are modified.

Author This is the group member or owner who performed or attempted an operation.

Target Name of the user involved

Result This indicates whether an operation was successful.

 Succeeded is shown if an operation was successful.

 Failed is shown if an operation failed.

 Denied is shown if an operation is denied.
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Check sent invites and shares for the group

When a user is invited to group, an invitation is sent to them. When a group member shares a folder with a 
group, the sharing invitations are sent to all other group members. All these sent invitations can be viewed or 
canceled from the wwSafe client. 

Permissions needed

You do not need special permissions to check the sent invites.

Only the owner of a group can cancel invitation to a group.

Sharing to a group cannot be canceled.

To view sent invites and shares for the group:

1. Select Manage Groups... from the Organize or click .The Groups window opens 
with a list of groups you belong to or own. 

2. Click on the name of a group to select the group and click . The “Sent shares” window 
opens. 

 

3. Uncheck “Only New” checkbox to display old invites along with any new notifications available

4. Click  to clear the window.

To cancel invitation to a group:

1. Select Manage Groups... from the Organize or click .The Groups window opens 
with a list of groups you belong to or own. 

2. Click on the name of a group to select the group and click  . The “Sent notifications” 
window opens. 

3. Click  near the invitation you want to cancel. The “Canceled successfully” message appears. Click 

 to clear the message.

4. Click  to clear the window.
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Sharing

Overview for Sharing

Each wwSafe folder can be shared with other users. This allows multiple users to have access to the same 
content in wwSafe.

Each folders can be shared with one or more individual users, one or more groups, or with a combination of  
users and groups. To share with a group, you must belong to or own the group.

Sharing permissions

When you share a folder, you assign permissions for the folder: 

 Individual users can have different permissions. 

 All members of a group have the same permissions.

Folder permissions apply to the folder itself  and to the files and subfolders it  contains. Permissions can be 
changed as needed. 

If you share a folder with a user individually and also share it with one of their groups, the permissions assigned 
to the user individually override permissions assigned to the group even if group permissions are higher.

What is shared

Only folders can be shared. Cabinets and individual files cannot be shared. In order to share a file, you share its  
folder. 

Changes to folder content are also shared. For example:

 When a file or subfolder is added to a shared folder, the file or subfolder is immediately available to 

sharing users. 

 When a revision to an existing file is added, the revision is immediately available to sharing users.

 When a file or subfolder is deleted from the folder, it is deleted for all sharing users. 

 When a file in a shared folder is renamed, all sharing users see the new name. 

 Note: If you add subfolders or files to a folder after you share it, they are automatically shared with sharing 
users. You do not need to invite users to share new subfolders.

Identify shared folders

To identify shared folders, look for sharing symbols:

 A plain folder indicates a folder is not shared by you or with you.

 A blue sharing symbol indicates that a folder is shared by you. The symbol is shown for the shared folder and 
any subfolders it contains. 

 A yellow sharing symbol indicates that a folder is shared with you. The symbol is shown for the shared folder  
and any subfolders it contains.

 A folder with the red symbol of cancellation indicates that sharing for the folder was revoked or that the folder 
was deleted by another user either with the delete feature or the Clean Up Cabinet feature. When you click on a 
folder with the red symbol of cancellation, the "Permission denied" message. You can delete the folder from your 
wwSafe window. 
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Share Folders

This topic covers inviting individual users and groups to share folders and their content (files and subfolders). 

 Tip: A folder can be shared several times with the same user. When a user accepts the new sharing invitation,  
their permissions for this folder are updated. 

Permissions needed

You can share all folders that you own. These are folders that you created or folders whose ownership was 
assigned to you by the last owner.

You can share folders that were shared with you if you have Share permissions for the folders.

To share a folder in wwSafe with one or more individual users: 

1. Select the folder you want to share by clicking on it in the left or right pane.

2. Select  Share...  from the Sharing menu or right-click on the folder in the left or right pane and select  
Share… from a pop-up menu. (The Share feature is available when a folder is selected.)

   

The “Share Folder” window opens.

3. Click Select a user... The Users pop up bar opens. Select a user by clicking on their name in the Select 
a user… list. (The list shows the names of all users whose PassKeys are registered with the wwSafe 
server.) The user's name is shown in the Share with: list.

4. Set an expiration time for the sharing invitation.

5. Set access rights for the user.

6. Click .

7. Repeat steps 2-6 for each user you want to share with. 

 Note:  After at least one individual user accepts a sharing invitation, the shared folder is marked in your 

wwSafe window with a blue sharing symbol  . It is marked in the window of the sharing user with a yellow 

sharing symbol . Any subfolders in a shared folder are also marked with a yellow or blue sharing symbol.
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To share a folder in wwSafe with one or more groups: 

1. Select the folder you want to share by clicking on it in the left or right pane.

2. Select Share... from the Sharing menu or right-click on the folder and select Share… from a pop-up 
menu. (The Share feature is available when a folder is selected.)

   

The “Share Folder” window opens. 

3. Select Share with a group.

4. Choose a group from the  Share with: list. (The list shows the names of all groups you belong to or 
own.)

5. Set access rights for the group. All group members have the same permissions level. The box Invitation 
valid for: (hours) is grayed out for groups. Invitations to groups do not expire.

6. Click .

7. Repeat steps 2-6 for each group you want to share with. 

 Note: After you share a folder to a group, the shared folder is marked in your wwSafe window with a blue  

sharing symbol . Any subfolders in a shared folder are also marked with the blue sharing symbol.

Accept Share Invitation

This topic covers accepting folder sharing invitations.

You can accept sharing when you receive an invitation to share. When you accept a sharing invitation, the folder 
is added to your wwSafe window and you are included in the Folder Permissions list for the folder. What actions 
you can perform for the accepted folder depends on the permissions level assigned by the user who shared a 
folder with you.

Permissions needed

You do not need special permissions to accept sharing invitation which was sent to you.
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To accept a sharing invitation:

1. Check the notification pane of the main wwSafe window. Sharing invitations appear there when they are  
received. 

 

2. Accept the invitation using the checkmark button   in the Notification pane. The “Choose Folder” 
window appears. 

3. From the “Choose Folder” window, select a storage location for the shared folder. The folder can be  
stored directly under the Cabinet or under another folder.

a. Select a Cabinet for the folder by clicking on the Cabinet name. (If you have only one Cabinet,  
click on that.)

b. If you want to store the folder in a top-level folder, click the right arrow beside the Cabinet. 
Then select the folder from the list  that appears. If you want to store the shared folder in a  

subfolder, click on the right arrow  beside a top-level folder and select a folder from the list of 
subfolders that appears.

4. Type a name for the folder next to Shared folder name. There is no limit to name length. Spaces can be 
used. When sharing users use the same name, this makes it easy to communicate about a folder and its  
files.

5. Click  to add the shared folder to your wwSafe window. A message confirms that the folder 
was shared.

The folder is marked with a yellow sharing symbol . The sharing invitation is removed from the Notification 
pane and its status is set to "Accepted".
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Check Folder Owner, Sharing Users and Permissions

This topic covers checking to see who has access to a folder and what their permissions are. 

This information is shown in the “Folder Permissions” window, which contains the following for a selected folder: 

 Name of the folder owner.

 Names of any users and groups that are sharing the folder.

 Folder permissions for each sharing user and group.

If  you are  the owner  of  a  folder  and other  users  and permissions are  not  shown when you  open “Folder 
Permissions” window for a folder, this means the folder is not shared. 

Features in the Folder Permissions window can be used to  change folder permissions for sharing users and 
change folder ownership.

 Note: The information shown in the “Folder Permissions” window for a folder applies to all the subfolders it  
contains. To see sharing users and permissions for the subfolders in a shared folder, open “Folder Permissions” 
for the shared folder.

Permissions needed 

You can view permissions for a folder if you are the owner or have one of the following permissions: View and 
Audit, Edit and Audit, or Share. If you have other permissions levels for a folder, you can see only the owner and 
your own permissions level. 

To view folder permissions and sharing users:

1. Select a folder by clicking on it in the left or right pane.

2. Select  Permissions from the Sharing menu or right-click on the empty space in the right pane (the 
folder should be opened) and select Permissions from the pop-up menu. (The Permissions feature is 
available when a folder is selected.) 

   

3. The Folder Permissions window opens. Check information as follows:

 Owner. Check this field to see the name of the folder's owner. 

 User Permissions. Check this pane to see the names of all individual users sharing the folder and 

each user's permissions level. 

 Group Permissions. Check this pane to see the names of all groups sharing the folder and the 

group's permissions level. All members of a group have the same permissions. (To see which users 
belong to a group, open the “Group members list” window.)
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4. Click  to close the Folder Permissions window.

Change Folder Permissions

This topic covers changing permissions for folders.

Follow the steps below to change a user or group's permissions for a folder. You can increase or decrease 
permissions levels as needed.

Permissions needed

You can change permissions for a folder if you are the owner or have Share permissions for the folder. 

To change permissions for a user:

1. Select a folder by clicking on it in the left or right pane.

2. Select  Permissions from the Sharing menu or right-click on the empty space in the right pane (the 
folder should be opened) and select Permissions from the pop-up menu. (The Permissions feature is 
available when a folder is selected.) 
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3. The “Folder Permissions” window opens. Double click on the name of the user in the upper pane.

4. The “Modify Permissions” dialog opens. Click in the  Access rights list and select a new permission 
level.

5. Then click   to  save it.  The  new permissions level  is  shown in  the “Folder  Permissions” 
window.

6. Click  to close the “Folder Permissions” window.
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To change permissions for a group:

1. Select a folder by clicking on it in the left or right pane.

2. Select  Permissions from the Sharing menu or right-click on the empty space in the right pane (the 
folder should be opened) and select Permissions from the pop-up menu. (The Permissions feature is 
available when a folder is selected.) 

   

3. Double click the name of the group in the lower pane.

4. The Modify Permissions window opens. Click in the  Access rights: list and select a new permission 
level.

5. Click  to save it. The new permission is shown in the “Folder Permissions” window.

6. Click  to close the “Folder Permissions” window.
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Change Folder Ownership

This topic covers changing folder ownership.

You can invite a sharing user to become owner of any folder you currently own. This allows you to ensure  
another user can manage folder content before you leave an enterprise or assume a new role.

When you invite someone to become folder owner, an ownership invitation is sent to their Notification pane.

The invitation can be sent with a custom message. This might provide information that can help the other user 
identify the folder in case they are using a different  name for that  folder. For example,  the message might 
describe the purpose of the folder or its content. The message might also identify you as the current owner in  
case the other user wants to contact you with questions.

If the user accepts the invitation, the following happens:

 The user becomes owner of the folder and has all permissions for the folder. Their name is shown next  

to Owner in the “Folder Permissions” window for the folder. The blue sharing symbol  is shown on the 
folder in their wwSafe window.

 Your permissions for the folder are changed to Share. Your name is moved to the list of users sharing 

the folder in “Folder Permissions” window. The yellow sharing symbol  is shown on the folder in your 
wwSafe window.

 Note: You can invite an individual user to become a folder's owner. They must already be sharing the folder.  
Their current permissions can be at any level. A group cannot be assigned folder ownership.

Permissions needed

You can change ownership for a folder if you are the current owner.

To change folder ownership:

1. Select a folder by clicking on it in the left or right pane.

2. Select  Permissions from the Sharing menu or right-click on the empty space in the right pane (the 
folder should be opened) and select Permissions from the pop-up menu. (The Permissions feature is 
available when a folder is selected.) 
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3. From the “Folder Permissions” window, click  .  This is activated if  you are the folder 
owner and one or more individual users are sharing the folder.

The Change Ownership dialog opens.

4. Click in the dialog's Select a person: list and select the user you want to transfer folder ownership to. 
The list shows all individual users who are currently sharing the folder.

5. Enter an expiration time for the ownership invitation in the Invitation valid for (hours) box. The default 
is 72 hours. To become folder owner, the user must accept the invitation before the expiration time 
passes. 

6. Enter a message to include in ownership invitation. This will be shown in the user's Notification pane.  
Entering a custom message is optional but can help the other user identify the folder if they have given it 
a different name.

7. Click  to send the change ownership invitation. 

8. Then click  to clear the message that confirms the invitation was sent. 

9. Click  to close the Folder Permissions window.
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Revoke Sharing for a Folder

This topic covers revoking sharing for a folder.

Sharing can be revoked for one or more of the users a folder is currently shared with. Afterward, the folder is no  
longer available for those users. They cannot open the folder.

If the folder was shared with a group, the sharing invitation to the group is cancelled. New group members will  
not receive an invitation to share the folder.

When you revoke sharing, you can choose whether to revoke it for:

 Selected sharing users and groups.

 All sharing users and groups.

Revoking sharing does not affect a folder's owner. Folder content is still available to the owner, even if sharing is 
revoked for all users.

The  folder  which  was accepted  by  you  has  a  cancellation  symbol  .  The  yellow sharing  symbol   is 
removed. If you try to access the folder, the "Permission denied" message is shown.

The folder shared by you is in the SEV window and folder content is still available. But the blue sharing symbol  

 is removed. 

 Note: Be aware that if a folder was shared with you and you revoke sharing for all users, your sharing is  
revoked as well.

Permissions needed

You can revoke sharing for a folder if you are the owner or have Share permissions for the folder. 

To revoke all sharings for a folder:

1. Select the folder by clicking on it in the left or right pane. 

2. Select  Revoke Share... from the Sharing menu. (Revoke Share is activated when a shared folder is 
selected.)

3. The Remove permissions window opens. Click  to revoke sharing.

4. A message confirms that sharing has been revoked. Click  to clear the message.
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To revoke certain sharings for a folder:

1. Select a folder by clicking on it in the left or right pane.

2. Select  Permissions from the Sharing menu or right-click on the empty space in the right pane (the 
folder should be opened) and select Permissions from the pop-up menu. (The Permissions feature is 
available when a folder is selected.) 

   

3. The “Folder Permissions” window is opened. Click x button   near the name of a user or a group 
whose share you want to revoke.

4. Click  to revoke sharing for the selected user or the group. The user or the group disappears 

from the list. Click  to clear the message.

5. Repeat steps 3-4 for each user and group you want to remove from the permissions lists. 

Permissions for Folders

Permissions determine what actions a folder owner or sharing user can perform for the folder and its content  
(files and subfolders). There are seven permissions levels, including the owner level. 

The owner of a folder automatically has all permissions for the folder. The owner is the user who created the  
folder or who was assigned ownership by the last owner. 

Other permissions levels are first assigned to a sharing a user or group when they are invited to share a folder. 
Permissions can be changed at any time by the folder owner or by a user with Share permissions for the folder. 

If a folder is shared with you individually and with one of your groups, you have the permissions assigned to you  
individually. This is the case even if the group has a higher permissions level.

 Note: You can check your permissions for a folder from the “Folder Permissions” window. You can see the 
permissions of other sharing users if you have one of the following permissions: View and Audit, Edit and Audit, 
or Share. 

WWPass wwSafe Version 2.1 User Guide 11/10/14

73 of 84



WWPass wwSafe User Guide

Permissions Levels

The table below shows the actions allowed for each folder permission level and for the folder owner. A green 
checkmark indicates an action is allowed. 

Actions Allowed 1 View 2 View 
and 
Audit

3 
Contribu
te

4 Edit 5 Edit 
and 
Audit

6 Share 7 Owner

View files in a shared folder; 
export files; rename folders

✔ ✔ ✔ ✔ ✔ ✔ ✔

View folder permissions of 
other sharing users ; audit 
history of changes for a 
shared folder and its files

✔ ✔ ✔ ✔

Add files, file revisions, and 
subfolders to a shared folder

✔ ✔ ✔ ✔ ✔

Rename files in a shared 
folder; rename subfolders in a 
shared folder ; delete files 
from a shared folder

✔ ✔ ✔ ✔

Change folder permissions of 
other sharing users ; share a 
folder that was shared with 
you; revoke sharing for a 
folder

✔ ✔

Change folder ownership ✔
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Notifications

Overview for Notifications

Notifications are messages which:

 you get when other users or wwSafe Security Administrators invite you to share a folder, to join a group, 

or to become an owner of a folder, or

 are sent when you invite other users or groups to share a folder, invite users to join a group or become 

an owner of a folder. 

You can check the received and sent notifications in the appropriate panes in wwSafe. 

By default, only new notifications are available for view. Check  here for the steps to shown old notifications. 
Notifications are new till you accept or reject them, or a sender cancels them, or the expiration date for these 
invitations passes. 

Get the latest notifications

Notifications are updated automatically when you login into wwSafe, and from time to time when wwSafe is  
opened. If required, you can update notifications manually. 

To update notifications manually:

 In the main wwSafe window: click  button to update either Received notifications 

pane, or Sent notifications pane. 

 In the Sent shares windows for groups and folders: click   button to update the notifications 

pane in the appropriate window. 

Received Notifications

When you login into wwSafe, the Received notifications pane opens at the Notification pane at the top of the  
main wwSafe window. It shows notifications sent to you by other users and wwSafe Security Administrators.

Sent Notifications

When you sent a sharing invitation, an invitation to group or an invitation to become an owner of a folder, you 
can check their status in a Sent Notifications pane. 

 Note: If you sent an invitation by mistake, you can cancel it. Click here for more information. 
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Check sent notifications

There are three ways to check sent notifications:

 Notifications pane in the main wwSafe window

 Sent Shares window for a folder

 Sent Shares window for a group

Sent notifications available from different panes:

Type Invitations available

Notifications pane in the 
main wwSafe window

The invitations sent by you:

 Sharing to an individual user

 Transferring ownership

 Invitation to a group

Sent Shares window for a 
folder

The invitations sent by you and other users you share a folder with:

 Sharing to an individual user

 Sharing to a group

 Transferring ownership

Sent Shares window for a 
group

The invitations sent by you and other users who are a member of a group:

 Invitation to a group

 Sharing to a group

To check the sent notifications in the main wwSafe window:

1. Click on the tab “Sent notifications” in the Notification pane.

The sent notifications pane opens. 
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To check the sent notifications in the Sent Shares window for a folder:

1. Select a folder by clicking on it in the left or right pane.

2. Select  Sent shares… from the Sharing menu or right-click on the empty space in the right pane (the 
folder should be opened) and select Sent shares… from the pop-up menu. (The Sent shares…feature 
is available when a folder is selected.) 

   

The “Sent Shares” window opens.

To check the sent notifications in the Sent Shares window for a group:

1. Select  Manage  Groups... from  the  Organize  menu  or  click  .  The  Groups 
window opens with a list of groups you belong to or own. 

2. Click on the name of a group to select the group. 

3. Click . The “Sent Shares” window opens.
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Columns in the Notifications panes:

Columns in the Notification show the following information:

Column Information Shown

Accept / Reject buttons Buttons available:

 Accept  button (only for the Received notifications pane) 

 Reject  button (only for the Received notifications pane) 

 Cancel  button (only for the Sent notifications panes) 

Buttons are shown for notifications which have the “New” status. They let you 
accept and decline invitations. Each notification has its own buttons.

Type Type of notification. It can be:

 “Sharing”

 “Invitation to group”

 "Transferring ownership"

 "Sharing to group"

From Who has sent the notification, name of a user or a group.

State State of the notification. It can be:

 “New”

 “Accepted” if you have accepted the invitation

 "Rejected" if you didn’t accept the invitation.

 “Cancelled” if a sender revoked the invitation

 “Outdated” if the invitation has expired

Expiration date Date and time the invitation expires. You must accept the invitation before then 
in order to share the folder. If the folder was shared with a group, an expiration 
date is not shown. Folder invitations to groups do not expire but remain in 
effect until the folder or group is deleted. As a group member, you can accept 
or decline the invitation at any time. 

WWPass wwSafe Version 2.1 User Guide 11/10/14

78 of 84



WWPass wwSafe User Guide

Accept a received invitation

You should accept an invitation you receive if you want to have an access to the issues which are sent to you 
with this invitation. 

You get the following access after accepting invitations:

Type Access

Sharing to individual users 
and groups

The  folder  is  added  to  your  wwSafe  window  and  you  (or  the  group)  are 
included in the Folder Permissions list for the folder. The operations available 
depend on the permissions level assigned when sharing was sent. 

Invitation to a group Membership in the group. The operations available depend on the permissions 
level assigned when you were invited to the group.

Transferring ownership You become the owner of a folder which was shared with you before accepting 
the invitation. 

 Note: All the invitations except invitations to share a folder with a group have the expiration period. You 
should accept these invitations before this period finishes, otherwise you should ask a sender to send you this  
invitation again. 

To accept an invitation:

1. Click the checkmark button  for a notification you want to accept before the invitation expires.

2. If you accept a sharing invitation, select a folder you want to accept share to. 

3. Then click   to clear the “Accepted” message. The accepted invitation is removed from the 
default  view at  the Received Notification pane in  the main wwSafe window and its status is set  to 
"Accepted". 

 Note:  If  you  accept  a  sharing  invitation  for  a  folder  which  you  already  share  with  other  users,  your  
permissions level is updated, and you get the following message:
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Reject a received invitation

You can decline any invitation you receive if you do not want to accept it. 

 Note: How one user responds to a sharing invitation does not affect other users who are invited to share. If  
one group member declines an invitation,  the folder is still  shared with group members who accepted their  
invitations. 

To decline an invitation:

Do one of the following to decline an invitation:

 In the Received notifications pane click the Reject button  for a notification you want to reject before 

the  invitation  expires. The  invitation  is  removed from the Notification  pane and  its  status  is  set  to 
"Rejected".

 Let the invitation expire. The invitation is removed from the Notification pane and its status is set to  

"Expired".

 Note: Group sharing invitations do not expire, so you can decline them only by clicking the reject button. 

Cancel a sent invitation

You can cancel any invitation you sent except a group sharing invitation. 

 Note: You can cancel only the invitations sent by yourself. If you try to cancel an invitation sent by another 
user, you get a “Permission denied” message. 

To cancel a sent invitation:

In any of the Sent notifications panes click the Cancel button  for a notification you want to cancel before the 
invitation expires. The invitation is removed from the Sent Notifications panes and its status is set to "Canceled".

View old notifications

After an invitation is accepted, rejected, canceled, or it expires, its notification disappears from the Notification  
Pane.  However, they remain available  for  viewing for  twice their  expiration time.  After  that  amount  of  time  
passes, they are permanently deleted from wwSafe.

To view old notifications:

 In the  main wwSafe window: Uncheck “Only New” checkbox in the Notifications drop down menu to 

display old notifications along with any new notifications available.

 In the Sent shares windows for groups and folders: Uncheck “Only New” checkbox . 
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Servers management

You can manage servers list if required. You can do the following:

 Add a new server. To see the steps to do click here. 

 Modify existing server. To see the steps to do click here.

 Delete existing server. To see the steps to do click here.

Modify existing server

You can modify the servers which are already in the servers list. This can be helpful if you need to make some 
corrections for this server – for example, change a port or correct a misprint. 

To modify existing server:

1. Click the Servers button  to open the Servers dialog. The “Servers” window opens.

2. Double-click on the name of the server you want to modify. The “Modify server” window opens.

3. Modify the data as needed and click  . If you do not want to modify the server’s data click 

.
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Delete existing server

You can delete an existing server if it is not required in the list. 

To delete existing server:

1. Click the Servers button  to open the Servers dialog. The “Servers” window opens.

2. Select the name of a server you want to delete and press . The server is deleted from 
the servers list and is not available in the list at the login window. 
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Audit Your User History

This topic covers auditing your wwSafe user history.

Your history is shown in the “User History” window. This includes the dates and times you logged into wwSafe  
and whether each login attempt was successful.

It also includes the rename and cleanup operations you performed for your Cabinets.

View the User History

Permissions needed

You do not need special permissions to view your user history.

To open the User History

1. Select User History from the Organize menu. 

2. Choose whether you want to open the whole history or history for the certain dates in the next window 

and click .

3. If you chose “History by dates”, select the dates in the “Choose dates” window. To navigate between the 

months use green buttons with arrows  . Click 
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4. The “User History” window will be displayed as follows:

 

5. Click  to clear the window.

Columns in the User History Window

Columns in the User History window show the following information:

Column Information Shown

Time This is the date and time you performed or attempted an operation. User history is sorted by 
time stamp, from newest to oldest, with oldest at the top.

Operation This is the operation performed by you or a wwSafe IT Manager. The following operations can  
be shown:

 A Cabinet  was cleaned up.  Shown when you cleaned up a Cabinet.  Cleaning up a 

Cabinet deletes all of its content.

 A Cabinet was renamed. Shown when you renamed a Cabinet.

 Authentication. Shown when you log into wwSafe and authenticate with your PassKey.

Result This indicates whether an operation was successful.
 Succeeded is shown if an operation was successful.

 Failed is shown if an operation failed.

 Denied is shown if an operation is denied.
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